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1 Overview
SmartView3 consists of the following independent programs/modules:

1.) SmartView Collector : the Collector is used to poll measurement data from the stations and
store the data in a MySQL Database.

2.) SmartCom is the communication module. This program is used by SmartView and SmartWeb
to access the data in the database. It also contains a flexible export/import module, and an
alarm module.

3.) SmartView3 is a PC Client program used to configure all SmartView3 modules.

4.) The SmartWeb module generates a web site to visualize the measurement data. Data is
displayed in tables and diagrams.
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2 Installation
Requirements :

PC with Windows 2000/XP or equivalent

Min. 512 MB Ram (1 GB RAM recommended)

The required processing speed depends on humber of stations/sensors to be polled, the
number of (data) pages to be generated, and the poll/update interval.

Minimum recommended (Collector only) is an Intel Pentium 4 (2 GHz) CPU or equivalent. For
larger installations with many stations, short poll/update intervals and web visualization a fast
Pentium 4 / HT / Dual Core / Extreme Edition processor may be needed.

MySQL Version 4.1 or 5.0

A fast LAN connection to the web server (diagrams, tables, and CSV files can take up quite
some space and need to be transferred to the web server)

Disk Space for database:

- configuration data: approx 120 Kbytes plus 1 Kbytes per Station

- per sensor value: approx 120 Byte

NOTE: for database maintenance (optimization, upgrades etc.) additional space is needed.
Please ensure there is at least double the disk space available!

Disk Space for Web-Sites. If you are using SmartWeb to produce web sites with you
measurement data, disk space to hold the web pages is required

Note on Language Selection / Translation:

All text elements used by SmartView3 are stored in an Unicode text file. With the program files we
provide one file with all text elements in English (SmartView3_en.uni), and one text file with “basic”
text elements (mainly the text elements used for the Web-Site, and some text elements used for
sensor type names etc.) in German (SmartView3_de.uni). If you plan to use a different language, it is
recommended to translate the text elements before installing SmartView3.

Please do not modify the text files provided with the program files, as they are updated with every
new version of SmartView3. To create a new translation, please copy the SmartView3_en.uni file (for
all text elements) or the SmartView3_de.uni file (for the basic text elements, i.e. the first part of
SmartView3_en.uni) to SmartView3_xx.uni (where xx is replaced by an abbreviation for your
language, e.g. “hu” for Hungarian, or “es” for Spanish). Then translate the text elements in the new
copy. SmartView3 will prompt you to select the language to be used during setup (if there is a file
other than SmartView3_en.uni available).

You can remove any entries that you don'’t translate from the new text file (see comments in the
provided text files). All entries not found in the new text file will always be taken from the “master” file
SmartView3_en.uni.

Step 1: Install MySQL (see www.mysql.com for product license information and download).
NOTE: MySQL setup must be run with administrator pr  ivileges!

Please reboot the system after installing MySQL to complete the installation. The MySQL
system service needs to be running in order to set up the collector database.

When installing MySQL, the installation program asks for the kind of database to be installed.
Collector does not use transactions, so the “Non-Transactional Database only " (MylSAM)
option is sufficient for Collector to operate.

The MySQL setup will ask for the MySQL Admin Password - this needs to be entered in the
“Setup Database” dialog (see below).

Note: SmartView uses MylSAM tables without transaction support (for performance reasons).
Please adjust the settings in the my.ini MySQL configuration file to your needs- especially the
“datadir” parameter - to your needs (see the MySQL manual for more information about
parameters for the MySQL database).

Note: if you plan to store many measurement values, make sure that the MySQL data folder is
placed on a NTFS partition, as FAT32 partitions only support files up to 4 GBytes.

NOTE on MySQL network access: if you want to run MySQL on a different computer than
Collector and SmartCom (which both access the MySQL database), the database (collector)
(not the tables in the database) needs to be created manually on the MySQL server, and
network access from all computers or from the computer(s) on which Collector and SmartCom
are running needs to be allowed for “root” AND for the MySQL user that you configure on the

2



informatik-werkstatt

Systementwicklung e IT-Management

“database setup” dialog (see below). The default password for the MySQL user “collector” is
“collector”. MySQL does not allow setting the access privileges for the database via network,
so the access privileges for the MySQL user (collector) to the database (collector) need to be
set on the server manually and the “MySQL user” must be created on the server manually as
well. THIS MUST BE DONE BEFORE YOU PROCEED WITH THE INSTALLATION!

The database can be set up on the “MySQL Server” by installing SmartView3 and running this
setup on the server as well — if the server is Windows based. Then you only need to ensure
that the “root” user has network access privileges. The database will then be created and the
MySQL user (collector) will be granted network access by the setup procedure described
below, and the software can be installed on the “client” computer.

If you run firewall software on the MySQL server computer, please make sure the MySQL port
(default 3306) is allowed in the firewall.

Step 2: Create a folder where you like to install the Collector program, e.g. “C:\Program
Files\SmartView3". Copy all program files to this folder.

Note: if you install SmartView on a Microsoft® Vista© system, it is NOT recommended to use
a folder in “\Program Files” to install SmartView, because Vista will place all files written by
program files to a folder below “Program Files” in the user’s “VirtualStore” folder, which is a
hidden folder. In this case the ini files for the SmartView program modules, and (if you do not
specify a different path below) the log files will be placed in that hidden “VirtualStore” folder,
and the ini and log files are hard to find. It is recommended to use a folder outside “Program
Files” to install SmartView on a Microsoft Vista system, e.g. create a folder “c:\SmartView3”
and copy the program files to this folder. You need administrator access rights, or the
administrator password to create that folder.

Step 3: Start SmartView3.exe. SmartView3 will start SmartCom, and then prompt for
installation/configuration information for the different modules of SmartView.

For most of the configuration options (except the MySQL Administrator password), the default values
can be used (just click “OK” on the various dialog boxes that are displayed).

The first dialog box configures, which modules run on the same computer, and which TCP/IP ports are
used by the modules to communicate :
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2.1 System Setup Dialog
systemsetup

x|
— Smartiew Settings

¥ Al Smartyiew programs run on this computer Cancel

¥ SmartCom runs on this computer

SmartCom Host Ilacalhnst

SmartCom Part IEEHU

¥ | Smnarteb e on this computer

Smarfeb Host ||Dca|hl:-$t

Smarth'eb Port IEEEIB

¥ Connect ta Smartweb

¥ | Callector runs o thiz computer

Callector Host ||Dca|hl:lst

Collector Port IEEEIEI

¥ Connect ta Collectar

Note: if you plan to run all programs only on the local machine, the default settings (host set to
“localhost”) are sufficient. If you plan to run SmartView3.exe from a different machine, and this way
access SmartCom/Collector via Network (or run SmartCom/SmartWeb or Collector on a different
computer), you need to uncheck the “All SmartView programs run on this computer” check-box. The
host name is then changed to the local computer name instead of “localhost”, and this way network
access is enabled. If “All SmartView programs run on this computer” is checked, and host is set to
“localhost”, network access to the programs is not enabled !

Next, the log file settings for SmartView3 and SmartCom are configured:
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Smart¥iew3 Log File Settings x|

— Log Settings
Lag File Directony ILDEI'\ Select | Cancel |
Errar Log ISmarNiewEEerr.th
Error Log Size IE— kA Byte:

Info Log ISmart\-"iewEInfD.t:-:t
|nfo Log Size IE— kA Byt

SmartCom Log File Settings il

— Log Settingz
Log File Directory ILDEI"'- Select | Cancel |
Error Log ISmartEu:um< datexErmor txt
Errar Lag Size IE— tByte
Infa Lag ISmartEu:um-(date}Infu:u.t:-ct
Info Log Size IE— MEyte

If you do not want to keep log files for SmartCom on a daily basis, please remove the <date> tag from
the filenames.
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2.2 Database Setup

Then, the parameters for the MySQL database are set.
You need to enter the MySQL Administrator password you entered when installing
MySQL

Database Setup x|
— D atabaze Settings

¥ MySEL runz on this computer Cancel

MySOL Host  |localhost MySEL Port e

Adrmit [raat] Paszward I"““’“‘ \ 4
D atabasze Mame IDD”EDtDr
kySOL Lger Iu:u:ulleu:tu:ur
MypSOL Password I""““"“

[T Ovenwrite duplicate zensor values

SmartView3 will now start SmartCom to create or update the database

Note: updating the database may take a lot of time, depending on the amount of
measurement data you have already stored in your da  tabase. Updating the database
from an earlier version requires that there isat|  east the amount of free disc space on
the volume where your MySQL database is located as  the sensor_values table requires,
because the table may be duplicated during the upda  te process!
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2.3 License

After creating or updating the database, the license information is set up.
The basic license allows you to run Collector for up to 5 stations — it does not support other
features like export/import, alarms or SmartWeb to create web sites.

Smart¥iew3 License il

— Licenze Settings

M amne I Cancel |

ke I

Even if you didn’t purchase an “extended” License, you still need to enter a license name and
a key. After you entered the license information, a dialog displays your license settings, e.qg.:

fo x|

License is Full License {unlimited number of stations)
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2.4 Collector Setup

Next, the log file settings for Collector are configured:

Collector Log File Settings

— Log Settingz

Log File Directarny ILDEI"'-

Select |

Error Log

Errar Lag Size

IED"EDtDr{ date:Error tat

IE tByte

|nfa Lag

Info Log Size

IEDIIectDr{ date:| nfo. ket

IE MEyte

Canicel |

If you do not want to keep log files for Collector on a daily basis, please remove the <date>

tag from the filenames.

Then a dialog to configure other parameters for Collector is displayed:

Collector Setup

— Modem Settings
M adern MName

Conexant HOA D30 WDC Y. 92 Modem
Standard 13200 bpz Modem

|2 3
tdoderm Errar Delay |5 T

tdodem Delay

selected
[highlighted)
modems are
configured to
be uzed by
collector

— General

Collector [D

—

Operations Mode

 Summer % Winter

Clack Syne Inkerval

|24 h

— Communication Settings
Connect Retries
Connect Retry Delay
Cammurication Retries

Station Poll Timeout

0

20 min

1

Cancel |

— Cam Pictures
[ Only Keep Last Ficture in Database

— LB
td aster Address

|55535

tax Clasz D

I? Skip zcan for devices in class after = timeouts

—

—TLSolP
¥ Enable TLSolP Server

E00

C_HelloDelay C_HeloTimeo

TCRAP Port |4422
C_ReceiptCount I'ID C_ReceptDelay |3U C_ReceiptT imeout I'IBD

ut  |EE0

170 Timeout

|2DEID

Here you need to select the modem(s) you would like to use with Collector to connect to the

stations (if you use dial up connections to your stations). You can assign the modems to

different “modem pools”.

If you plan to use TLSolP based stations, you need to enable “TLSolP”, and set the TLSolP
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parameters to your needs.

SmartView3 then prompts to start the Collector. If you did not upgrade from a previous version
of Collector, there are no stations configured yet, so you may want to start the Collector later
after you configured your stations
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2.5 SmartWeb Setup

If your license includes SmartWeb, the SmartWeb log file settings are configured next:

SmartWeb Log File Settings il

— Log Settingz
Log File Directary ILDEI"'- Select | Cancel |
Error Log ISmartWeI:u< datesErrar txt
Errar Lag Size IE tByte
Infa Lag ISmartWeI:u<date>lnfu:u.t:-:t
Info Log Size IE ME ke

If you do not want to keep log files for SmartWeb on a daily basis, please remove the <date>
tag from the filenames.
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2.6 Administrator User

Now, the administrator user for SmartView3 is set up. You need to set up at least one
administrator user by entering a user name and the password (all other information may be
left blank).

edieuser x|
] 8 |
zer 1D I1 Cancel |

Ilzer Hame

Paszward

Paszward

Firztname

Lastname

Company

E mail

Group I.-’-\.u:lministrah:ur j

[=zer Privileges |

After you entered the user information, SmartView3 is started, and you can configure your
stations and web site(s).
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3 The Modules

3.1 Collector SmartView3

Collector runs as a background program. When started, it is minimized, and shows as an icon in the

system tray bar:

%

If you double click this icon, or if you right click the icon and select “show” from the pop-up menu that
appears, the program is shown:

Collector Smart¥iew3 ¥Yersion 1.3.1

=10] %]

 Statiots
Mumber of Stations I? Active I'I Inactive |5

h arne | Mext Pall | Last Transfer | Statuz | Drevice Tinne
LIME v 200801430 10:22:00 2008/01/301%:21:01  idle

4| |+
20080130 10:18:07 - Station "UMB I device: "COM1'™: data written [total transfer time 0 zec), transfer ends. ;I
20080030 10:1%:07 - Station "UME W' device: "COM1'™ connecting

200801430 131902 - Station "UME I device: "COMT'™ 2 zensor walues raad

2008400 /30 10:13:02 - Station "UME 1" device: "COM1'": transfer done [1 zec] - vwiiting data...

200801430 10:13:02 - Station "UMB V"' device: "COM1"™: data written [total transfer time 1 zec), transfer ends.

20080030 10:20:07 - Station "UME V"' device: "COM1'™ connecting

20080130 10:20:00 - Station "UMB I device: "COMT'™ 2 zensor walues raad

2008400 /30 10:20:01 - Station "UME 1" device: "COM1'": transfer done [0 sec] - vwiiting data...

200801430 10:20:07 - Station "UMB V"' device: "COM1'™: data written [total transfer time 0 zec), transfer ends.

200801430 10:21:07 - Station "UME "' device: "COM1"™: connecting

200801430 10:21:02 - Station "UMB I device: "COMT'™ 2 zensor walues read

2008407 /30 10:27:02 - Station "UME I'Y"' device: "COM1'": transfer done [1 zec] - wiiting data...

2008401430 10:21:02 - Station "UMB V"' device: "COM1"™: data written [total transfer time 1 zec), transfer ends.
4] »

E =it |

|1D:2'I:24

The configured stations are shown in the upper part of the window, showing the next station due to be

polled first.

In the lower part of the window status/information messages are displayed

Configuration information for Collector is (if not stored in the database) held in the Collector.ini file.

3.2 SmartCom

The SmartCom module provides access to the database for SmartView3 and SmartWeb, and contains
the “export/import” and “alarm” functions.

Like Collector, SmartCom accesses the MySQL database via the libmysql.dll

library provided by

MySQL. This library must be accessible by the program, i.e. it must be installed on the computer so
that it can be found by the operating system (either in an appropriate system directory, or in the
directory where the SmartCom program is located).
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It is recommended to run SmartCom and Collector on the same computer where the database is
located, to minimize network traffic when accessing the database.

Like Collector, SmartCom is run as a background program, and is minimized to the system tray when
started.

@

If you double-click the icon in the system tray, or right click the icon and select “show” from the pop-up
menu, the SmartCom window is displayed:

In the upper part of the window, any configured automatic export jobs are displayed. Below that, the
SmartView3 modules that are connected to SmartCom are shown. In the lower part, error and
information messages are displayed.

Configuration information for SmartCom is held in the SmartCom.ini file.

3.3 SmartWeb

SmartWeb is the module that creates the web pages and uploads these pages to a web server (if ftp
upload is configured for a site)

SmartWeb communicates with SmartCom to access the data in the database indirectly.

The program is designed to be run constantly (after the site has been configured initially using
SmartView3). You may want to place a link to the SmartWeb program in the “Autostart” folder of your
system. Note that SmartCom must be running in order for SmartWeb to start - if you run SmartWeb
and SmartCom on the same PC make sure to start SmartCom before starting SmartWeb.

Like Collector or SmartCom, SmartWeb runs as a background program and is minimized to the
system tray after startup:
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If you double click the system tray icon, or right click the icon and select “show” from the pop-up menu,
the program window is displayed:

In the upper part of the window, all pages of all configured web sites are displayed, with information
about when the pages were updated last.

In the lower part of the window, error and status messages are displayed.

Configuration information for SmartWeb is held in the SmartWeb.ini file.

3.4 SmartView3

SmartView3 is the configuration program for all functions/modules of the software package.

In future releases, SmartView3 may also provide functions to view and analyze the measurement data
in diagrams and tables.

SmartView3 communicates with SmartCom to access data - it does not access the database directly.
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4 SmartView3 Menus

4.1 Main Menu

The main menu contains the following menu items:

411 File

Manual Import/Export : configure/run a manual import/export job
Exit : exit SmartView3

4.1.2 Edit
Configure Stations, Web-Sites, Export/Import and Alarm settings

Stations: view Collector status and configure stations
Web-Sites: configure web sites

Export/Import: configure automatic export/import jobs
Alarm: configure alarm settings for stations and sensors
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Setup

Setup options for SmartView3

4.1.4

Database : the database settings

System: SmartView3 system setup (hosts and IP ports for the SmartView3 modules)
License: setup SmartView3 License

Device Sensor Types: edit device sensor types

Units: edit units

Logical Sensor Types: edit logical sensor types (Sensor Type Templates)

Value Mapping: edit value mapping templates

Status Mapping: edit status mapping templates

Deleted Stations: manage deleted stations, i.e. either “undelete” a deleted station, or remove
the station and all related data completely.

Backup/Archive data: setup automatic backup and/or compression of data

Delete Sensor Values: delete values for selected sensors from database

Collector: edit Collector options

SmartWeb: edit SmartWeb options

SmartView: edit SmarView3 options

Users and Groups: edit users and groups

Logoff: logoff current user

Modules

Start/Stop Smartcom: start or stop the SmartCom program
Start/Stop Collector: start or stop the Collector program

Start/Stop SmartWeb: start or stop the SmartWeb program

Show SmartCom: show the SmartCom program window (if running)
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Show Collector: show the Collector program window (if running)
Show SmartWeb: show the SmartWeb program window (if running)
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5 Configure Stations

To configure stations, select “Edit->Stations” from the main menu.

This opens the station/collector status view window:

5.1 Station status

The window shows all configured stations, and the status of the station in Collector, e.g. the status of a
station if it is currently polled by collector (and the collector is running).

To edit a station, double click the station in the list, or select the station and select “Station->Edit” from
the menu.

The list of stations can be sorted by “ID”, “Name”, “Type”, “Modem Pool”, “Next Poll”, “Last Transfer” or
“Status” by clicking on the appropriate column header.

To create a new station, select “Station->New” from the menu, or left click in the station window to
show the pop-up menu. The pop-up menu contains the same menu items as the main menu “Stations”
(which is available when the station window is opened).

“Edit Station” or “New Station” will display the station configuration dialog (see below).
“Poll Now” will re-set the “next poll” time for the selected station to “now”.

“Station active/inactive” will toggle the active status of the station.

“Abort transfer” will abort the transfer in progress for the selected station
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“Poll All Stations Now” will re-set the “next poll” time for all stations to “now”.

5.2 Station Settings

521

Station ID : the (program internal) station id

Is Active: station is active (or inactive)

Sensor Details: shows information about all sensors of a station (see below)

Name: the name of the station

Station Type: the station type

Read online data/Read stored data/Read all stored data: read online data or data stored in
logger. If “read all stored data” is selected, the start time for reading the logger data can be
set in the edit field below the selection box.

Station Schedule: this list contains one or more station schedule entries (see below)

Next Poll: time station will be polled next

Cam Station ID: station id of a Cam FTP/HTTP station associated with the station (0 = none)
Location/Altitude/Latitude/Longitude: location information about station

Check Configuration: check the station configuration every time a station is polled

Device Details: shows information about all devices at the station

Connection Type: the connection type for the station. Depending on the connection type,
different connection parameters can be configured

Timeout/Timeout (long): Timeout settings for device 1/0

Clock Settings: time/clock settings for station.

NOTE: when reading data from the device memory (sto  red data), the clock settings
MUST BE SET to the device clock settings, evenift  he clock is not automatically
synchronized- otherwise the time information for th e retrieved data may not be correct!
Set Time: synchronize the stations clock automatically to the system time, depending on the
time zone settings

Statistical Information: some statistical information about the station

Station Sensor Details

Clicking on the “Sensor Details” button opens a window that displays all sensors for a station:
Note: sensor information is only available if the station has been polled successfully at least once.
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Disabled sensors are displayed in gray. For all active sensors, the last value time, last value and unit
are displayed.

To view/edit the station sensor settings, double click the sensor in the list, or select the sensor and
click the “Edit Sensor” button.

Buttons:
Ass. Log Type: open dialog to show/change logical sensor type assignments for every active
sensor of the station
Add Calc Sensor: add a calc sensor (see below)
Delete Calc Sensor: delete a calc sensor (see below)

To assign a logical sensor type to every active sensor.
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5.2.1.1 Sensor Information

For all sensors reported by the device, the “sensor information” dialog is displayed. For “calculated
sensors” please see chapter 5.2.1.2 below.

The station sensor information is displayed.

Dependmg on the station type, following configuration details may be set:
Is Active: for UMB devices, a selected sensor/channel can be set active (will be read) or
inactive (will not be read). For all other device types, this cannot be changed (depends on the
device configuration)
Sensor: The (within a station unique) sensor nr assigned to this channel. The sensor nr is
used in web site pages and in export jobs to refer to a specific sensor.
Value Mapping: mapping of sensor values — applied before values are stored to the database
(see Value Mapping)
Sensor Type (phys): the device sensor type
Sensor Type (log): the logical sensor type.
Note: SmartView automatically assigns a logical sensor type to each sensor (as far as
possible — for some Opus200 sensors it cannot be assigned automatically). This may however
not be the correct sensor type. You should check and assign an unique logical sensor type to
each (active) sensor of the station. If, for example, you have a station with multiple road
sensors, please create new logical sensor types (Surface Temperature 2, Road Condition 2
etc.) for each additional road sensor, so each sensor has a unique logical sensor type
assigned.
Sensor Name: the name used for this sensor/channel. For Opus200 devices, this name is
stored in the device, and changing the name will result in a configuration change of the device;
The change will not be visible until the station is polled next time and the change is applied to
the device
Channel Mode: this can only be changed for Opus200 devices
Store Interval: this can only be changed for Opus200 devices
Sample Interval: this can only be changed for Opus200 devices
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5.2.1.2 Calculated Sensors

If a “calculated sensor” is added or edited, the following dialog is displayed:
At the moment only “simple” calculations (min/max/avg/sum/diff and value mapping) based on one
“souce sensor” are supported.

Sensor Name : name for the calculated sensor
Device Sensor Type : (device) sensor type for the calculated sensor — select from list or
create a new type
Sensor Type (log): logical sensor type for the calculated sensor — select from list or create a
new type.
Calc Type : calculation type for sensor:
Currently following types are supported:
0 Value mapping — use Value Mapping (see below) to calculate new value for each
source sensor value
Min — calculate minimum value for each given Calc Interval
Max — calculate maximum value for each given Calc Interval
Avg — calculate average value for each given Calc Interval
Sum - calculate sum value for each given Calc Interval
Diff — calculate difference for counter values, e.g. precipitation amount from absolute
precipitation for UMB R2S sensor
Calc Interval : time interval for min/max/avg/sum calculation
Value Mapping : Value Map to be used for “value mapping” calculation
Source Sensor : the source sensor for the calculation

O O0OO0OO0oOo

Calculation for a calc sensor is done whenever new data for the source sensor is read from the
device. The calculation is done in the “Collector” program after saving the new sensor values.

Using “Calculate values with all available data” you can (re-) calculate the values for this sensor for all
available data for the source sensor.

Note: the timestamp for calculated values that are calculated over a given interval (i.e.
min/max/avg/sum calculation) is set to the end of the given interval, e.qg. if the interval is “day”, the
timestamp will be 23:59:59 hours of the given day etc.
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5.2.2 TLSolP Stations

Configuration for a TLSolP station differs from other station types, as in this case the communication
between the station and Collector is not initiated by Collector, but by the station. In order to support
TLSolP stations, TLSolP must be activated in the Collector Setup Dialog (see Collector Setup).

TLSolP stations are recognized by their uniqgue OSI7 address. If a station connects to Collector, the
database is searched for a configured station with this OSI7 address. If not station with this address is
found, Collector automatically configures a new TLSolP station for the OSI7 address.

Configuration parameters for a TLSolP station are (besides general items like an assigned CAM
station or the location information) limited to the station name and OSI7 Address.

5.2.2.1 Sensors for TLSolP Stations

If an TLSoIP station connects, it will typically send “DE-Status” messages for all sensors configured in
the station to the server (i.e. Collector). TLSolP sensors are recognized by their “FG”, “Channel” and
“Type” configuration. DE Status Messages only contain FG and Channel information. If no sensor for

this FG/Channel can be found in the database, an error message is written to the log file.

If the station reports sensor values, FG, Channel and Type are transmitted with the sensor value. If no
sensor for this FG/Channel/Type can be found in the database, Collector will automatically configure a
new sensor.

This way Collector will automatically configure all necessar y data for a TLSolP station if the
station does report sensor values for all configure d sensors . If there are sensors configured in
the station that are de-activated, or do not report values (e.g. because the sensor is defect), Collector
will not be able to auto-configure that sensor — and thus will not be able to display the error status for
such a sensor. To cover this, you can manually add/edit/delete sensors for TLSolP stations:
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To add a new sensor to a TLSolP station, you need to enter the FG, Type and Channel for the sensor:

If you edit an already configured sensor for a TLSoIP station, an additional button “TLS Settings” is
available to change the FG/Type/Channel assignments for a sensor:

The TLS FG is stored in the “Sub ID” attribute for the sensor (and the “Device Sensor Type” attribute
of the Device Sensor Type information), the TLS channel is stored in the “Channel” attribute. The TLS
Type is stored in the “Sub-Type” attribute of the Device Sensor Type information.
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5.2.3 Reports
This dialog shows a report with statistical information for sensors of the station:

Depending on the selected time interval (can be day, month, or year) the appropriate values are
shown in a table.

If “day” is selected, average (or sum) values for every hour of the day are shown, and the minimum,
maximum, average or sum values for the day are displayed.

If “month " is selected, average (or sum) values for every day are shown, and the minimum, maximum,
average or sum values for the month are displayed.

If “year” is selected, average (or sum) values for every month of the year are shown, and the
minimum, maximum, average or sum values for the year are displayed.

The “<<” and “>>" buttons can be used to display the previous/next time interval.

Per default, all (active) sensors of a station are displayed. Using the “Select Sensors ” button, sensors
can be selected, and the sequence of the sensors can be altered.

“Print ” will print the displayed report data.
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“Export " will export the displayed report data to a .csv (text) file — e.g. for import and processing in
Microsoft Excel etc. Some parameters can be set to specify the export format:

5.2.4  Station Device Details

Clicking on the “Device Details” button opens a window that displays all devices for a station.
Note: device information is only available if the station has been polled successfully at least once.

For TLSolP stations, no “Device Details” are available.
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5.2.5 Station Schedule

You may configure multiple schedule entries for a station.

- Mode: operations mode for schedule entry (Any, Summer or Winter)

- Type: type of entry (Run or Exclude)

- Every xx interval: run every xx interval, e.g. every 20 minutes, or every 1 day...

- Hour/Offset: hours/min/seconds to be added to begin of interval, i.e. the time of day for interval
“day, week, or month”

- On Day(of week or month) — if the interval type is week or month, you can set the day of week
or month the station should be polled

- Exclude from/to: for schedule entries of type exclude, this specifies the time (of day) the
station will not be polled

Possible time intervals are:
every xx minute
every xx 5 minutes (to the full hour, i.e. 00:00, 00:05, 00:10 etc)
every xx 10 minutes (to the full hour, i.e. 00:00, 00:10. 00:20 etc) [ same as every 2 5
minutes..]
every xx 12 minutes (to the full hour, i.e. 00:00, 00:06, 00:12, 00:18...)
every xx 20 minutes (to the full hour, i.e. 00:00, 00:20, 00:40...)
every xx 30 minutes (to the full hour, i.e. 00:00, 00:30,...)
every xx hour
every xx day
every xx week
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6 Configure SmartWeb pages

6.1 Overview

The SmartWeb configuration consists of the following objects:

6.1.1 Site

A site refers to a “web site”, which may contain data from multiple stations. A “Site” consists of “Pages”
of different types (see below).

The pages that are generated by SmartWeb for a site are always stored on the PC where SmartWeb
runs (in the directory indicated by the “local path” field of the Site configuration), and can be viewed
using a web browser (i.e. Internet Explorer, Mozilla Firefox, or Opera...).

The “start” page of a site is the file “index.html” in the “local path” directory — open that file in your
browser to view the data.

The pages of a “site” can of course also be accessed via a web server. You could either install a web
server (like Apache) on the same PC where you are running SmartWeb, and configure the web server
to use the “local path” of the site as “document root”, or configure SmartWeb to use the “document
root” (or a directory below that) as local path. Or you can configure SmartWeb to transfer all files to an
external web server.

Note:

The generated website contains active elements and Javascript code used for navigation and popup
texts. Make sure your web browser is set up properly to allow the use of active elements.

When viewing the generated web site from the local disc with Microsoft Internet Explorer, Internet
Explorer always pops up a warning about “active elements”, and blocks these elements.
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The structure of a SmartWeb generated web-site is as follows:

Map/Overview
page
- Station page 1
- Station page 2
Stations . -
N Station page 3
s )
Data Pages » Data page 1
\\
7\ Data page 2
\\ Data page 3 Archive page
T 1 for Data
paaqg

Archive page

1 for Data
page 1

\<.. Archive page
x for Data
\ 4

page 1
Archjve List /

Archive Menu

A 4

\ for Data page
1

- Archive List
for Dataypage

2 Archive List

for Data page
3

Contact
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6.1.2 SmartWeb Pages
SmartWeb will generate following types of pages:

6.1.2.1 Map page- “Overview”

This is the “start” or “home” page of the site. It shows the status of all stations configured for this site
either in a table (with a link to the “station page” for this station), or (graphically) on a map.

The map page is the first menu item on the menu generated by SmartWeb on the left side of each
page.

The “title” of this page is used in the menu, and can be customized in the “edit page” dialog for this
page.

If you loaded a map for this page, and placed your stations on the map using the appropriate dialog
(see below), the stations will be displayed on a map as colored squares, with the color indicating the
status of the station, i.e. green when there was no error, or red if the station could not be polled or
there were error or alarm values for sensor values. If you scroll over a station icon on the map, the
station name and status is displayed, as well as the last sensor values (if you configured sensors to be
shown on the “station icons”). Clicking on the station icon will take you to the appropriate station page
(see below).

On the “map page”, a link to the “Table” overview is provided.
If no map is configured, only the “Table” overview is created.



informatik-werkstatt

Systementwicklung e IT-Management

The “table overview” shows status of all stations, and the sensors configured for the “station icon” of
each station in a table. Sensors with identical logical sensor type, value type and unit are shown in the
same column. There is a param for the “Overview page” (see below) to configure the maximum
number of sensors displayed in one table.

If there is a map configured for the Overview page, a link back to the map page is available on top of
the table overview page.
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6.1.2.2 data list page

This page contains a list (with links) to all data pages generated by SmartWeb. A “data page” is a
page showing sensor values in diagrams and tables.

The “data list page” is the second menu item on the menu created by SmartWeb on the left side of
every page.
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6.1.2.3 station list page
The “station list” page lists all “station pages” with a link to the appropriate station page — similar to the
“map page” if the map page is not configured to show the stations on a map. The station list page

does not show status information for a page.
The “station list” page is the third menu item on the menu created by SmartWeb on the left side of

every page.
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6.1.2.4 archive menu page
The “archive menu” page contains a list with all “archive list” pages. There is an “archive list” page for

every data page configured.
The “archive menu page” is the fourth menu item on the menu created by SmartWeb on the left side of

every page.
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6.1.2.5 other page / Contact

This is the “contact” page (a page of type “other page”). It is the fifth item on the menu created by
SmartWeb on every page
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6.1.2.6 data page

Data pages are used to display data in diagrams, tables and reports. The sensors that are displayed
on a data page can be selected from all stations that are configured for a site.

A Data page always displays data for a specified (fixed) time interval. If this time interval is in the past,
the page is referred to as “archive page” (and is no longer updated by SmartWeb).
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6.1.2.7 station page

There is one “station page” for every station configured to a web site.

On the station page, the last sensor values for selected sensors of a station are displayed. If there is a
cam station associated with the station, the cam picture is shown on the station page as well.

In addition, some statistical information about the station is displayed.

Last sensor values can be displayed in tables and/or as “analog gauge” displays for every sensor.

“Reports” that show min/max/average/sum values for selected sensors for specific time intervals can
be added to the station page.

Links to “data pages” for the station are provided on top of the page

6.1.2.8 archive list page

For every data page there is one “archive list” page.
An “archive list” page lists all “archive” pages for a data page. As mentioned above, an “archive” page
is a data page that is no longer updated, i.e. contains data from the “past”.
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6.1.2.9 archive page

An archive page is an “old” data page, i.e. a data page that is not updated anymore, because its time
range is “in the past” (e.g. last week, if the data interval for the data page is “one week”).

Archive pages can be accessed either via the “Archive Menu” / “Archive List” page, or by clicking the

appropriate navigation button on the “data page” (which is the “current page” on the archive list page).
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6.2 Getting Started

To create a SmartWeb site, select menu item “Sites” from “Settings”. This will open a window titled
“Web Sites/Pages”.

If no web-sites are configured, only the “Templates” are displayed,

Template pages are used to provide an easy way to create identical station and data pages for
multiple stations.

In Template pages, logical Sensor Types are used instead of “real” sensors. When a template is used
to create a station or data page, the “real” station sensors are mapped to the logical sensors used in
the template (the same applies to template export/import jobs, see below).

Following default template pages are provided with SmartView:

Road Sensor Station : a “station” page with analog gauges etc. for a typical road sensor
station with one road sensor

Agro Station: a “station” page with analog gauges etc for a typical meteo/agro station

Meteo Data: a “data” page with diagrams and tables for a typical “Meteo” data station (air
temperature, rel. humidity, dewpoint, air pressure, precipitation amount and type, wind speed
and direction, solar radiation, leaf wetness)

Road Sensor and Meteo Data: a “data” page with diagrams and tables for “Meteo” data and
data for one road sensor

Agro (Meteo Data and Plant Disease Models): a “data” page with diagrams and tables for
“Meteo” data and data for all 5 plant disease models (Oidium, Botryis, Peronospora, Venturia
and TempSum) available from Lufft.

Oidum/Botrytis/Peronospora/Venturia/ Tempsum: “data” pages with diagrams for the
respective plant disease models available from Lufft.

You can alter the existing templates, or create new templates, to your needs.

Note: if you have multiple sensors of the same type (e.g. air temperature, visibility, or road sensors) at
your stations, you need to set up own logical sensor types (e.g. “air temperature 2", “visibility 2", “road
condition 2" etc) for the multiple sensors, and use those new logical sensor types in the template
diagrams (and assign them to the appropriate sensors in the station configuration) in order for
SmartView to pre-select the appropriate sensors when assigning station sensors to templates (see
below). If you don’t create new logical sensor types, SmartView cannot pre-select the proper station
sensors, and you will have to manually select the sensors when assigning the page template.

To create a new web site , you can either select the option “New” from the “Web-Site” menu in the
menu bar, or from the pop-up menu that appears when you right-click at the empty window. This
opens the “Site Edit Dialog” (see Edit Site Dialog ).
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Note: Before you add a station to the web-site, you need to poll the station at least once to read the
station’s sensor configuration. For stations of type UMB, you also need to activate the specific
channels (sensors) you would like to use before you add the station to the web site.

If you plan to use plant disease model calculations for your (agro) station, it is recommended to
configure the Export/Import jobs for the plant disease models first (see below), so that the “import”
sensors for the plant disease models are available when setting up the station for the web site

Select the stations to be used in this site by clicking the “Edit Stations” button (see Select Site
Stations).
Click OK to save the new site.

For each station you add to the web site, a dialog to select a (station) template page for the station is
displayed:

You can set up a station without using a template page.
If you selected a template, SmartView checks if there is a logical sensor type assigned to every
(active) sensor of the station. If not, a dialog is displayed to assign the logical sensor types

You can select a logical sensor type from the drop down box. If there is no pre-defined sensor type
that fits you sensor, you can create a new sensor type using the button “Edit (log.) Sensor Types.
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A Dialog to assign the station sensors to the page template (i.e. to all the page elements of the
template page) is displayed next:

The page elements that don’t have a sensor assigned will not be added to the resulting page.
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For station pages, a table containing all active sensors of the station is created automatically.

Click “OK” to add the station (and station page) to the web site.

The pages for the new site will be created, and displayed in the Web Site/Pages window.

The window displays all elements a SmartWeb web site consists of. See Web-Site Elements below.

You can expand the display to show subordinate elements by clicking on the “+” signs.

Now you can add “data” pages to display data in diagrams and tables (the station page only shows the
last sensor values).

You can either double click on “Pages” (which opens a dialog showing all pages of the site, that has
buttons to add and delete pages), or you can select “Pages” or an entry below “Pages” with the left
mouse button, and then open the context menu with the right mouse button and select “new”.

This opens a dialog to select the page type you would like to add
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You can either add a data page, or a “link page” (see below).
If you add a data page, the dialog to select a template for your data page is displayed :

If you selected a template page, a dialog to select the station is displayed. Template pages can only
be used to show data from a specific station. If you like to add a data page that contains data from
multiple stations, you have to set it up manually without using a template.

Select the station you want to use for the data page.
SmartView checks if there is a logical sensor type assigned to every (active) sensor of the station. If
not, a dialog is displayed to assign the logical sensor types.
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Next, the dialog to assign the station sensors to the page elements (diagrams, tables etc), is
displayed. If there are many page elements on the page, you may have to scroll down to see all
assignments.
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Only page elements that have sensors assigned will be added to the resulting page.

A dialog showing the new page is shown:
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You can change the pre-set page title and data interval etc. for the page, and check/modify the page
elements etc. before actually saving the page by clicking “OK”. Of course you can change the page at
any time, or re-apply a template page later.

Customizing the general layout of your web site:

If you want to use a different site logo, click on the “Site Elements” entry to show the subordinate
objects:

Now double click on the “Site Logo” entry to open the “Edit Site Element” dialog for the logo. Now you
can change the logo by clicking the “Read from File” button (see Site Elements, Edit Site Element).
Please make sure your logo has the same size (175x65 pixel) as the one provided.

If you would like to show your stations on a map, double click the first entry under “Pages” named
“Overview”.
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Click the “Edit Map” button on the right side of the Edit Page dialog that is displayed (this button is only
displayed for the Overview page).

Now the “Edit Page Element” dialog is displayed, where you can load the map to be used by clicking
the “Read form File” button. Close the Edit Page Element dialog with “OK”

Now the “Map Editor” - see Edit Map will be displayed, and you can position your stations on the map.
All stations are placed in the upper left corner of the map on top of each other if the dialog is opened
the first time. Move the stations to the required position on the map by clicking and holding the left
mouse button on the station (the rectangle), and release the mouse button.

Click “OK” - this will save the page.

If you didn’t start SmartWeb already, start it now (e.g. by selecting “Start SmartWeb” from the
“Modules” menu).

Note: SmartWeb will now create all pages. It will create data pages for all available data in the
database - i.e. if you already have data in the database, it may take some time for SmartWeb to
generate all pages and upload them to the configured web server.
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6.3 Web-Site Elements

The following diagram shows the elements a SmartWeb web site consists of.

Site Elements

Site Logo
CSS File
Javascript File
Page Sensors
. . For page type “data
Site : page” and “station
) Name Stations page”
Site Header/Footer N . Stations displayed . May be selected
FTP Server v on this site from all stations
Default Page associated with this
settings Site for data pages.
Pages
Type
Title, Subtitle...
Data Interval Page Elements Element Sensors
. Type (depending on page . For page elements ,line
\ type), e.g. “Bitmap” or “Station | diagram®, ,horizontal bar
Icon” for “map page”, “Text” for > diagram“ ,table", round
“other/contact” page, or “Line . May be selected from all sensors
Diagram”, “horiz. Bar Diagram” configured for this page.
and “Table” for “data pages”, - For “line diagram” : color for this
“Round Gauge”, “Wind Rose”, sensor in diagram
“vert. Bar Graph”, “Color . For “bar diagram”; one “sensor”
Code”, “Pictogram” or “Table” for each value interval with

for station pages associated color
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6.4 Customizing Pages and Diagrams

You can customize the layout of the diagrams for each data page to meet you needs.
Diagrams and Tables are shown as subordinate elements of data pages in the “Web Site/Pages”
display.

A double click on an entry/element in the “Web Site/Pages” display opens a dialog depending on the
type of entry you select. Clicking the right mouse button when an entry/element is selected opens a
context sensitive menu that allows you to edit, delete, or add a new element of the selected type.

The sensors associated with each diagram or table are shown as subordinate elements of the
respective diagram or table:

A double click on a page (all entries subordinate to “Pages/Data Pages”) opens the “Edit Page”
dialog. Here you can configure attributes for the page like the page title and sub tile, or the data
interval to be used in diagrams on data pages.

A double click on the “Sensors” entry subordinate to a page opens the “Select Sensor” dialog. If the
data page is associated with a specific station, only sensors for this station can be selected. If it is not
associated with a specific station, sensors from all stations configured for this web site can be
selected.

A double click on the “Diagrams/Tables” entry subordinate to a page opens the “Page Elements”
dialog. Here you can edit, delete and add new diagrams or tables, or re-arrange the sequence of page
elements (diagrams or tables).

A double click on a diagram or table opens the “Edit Page Element” dialog. Depending on the page
element type (e.g. “Line Diagram”, “horiz. Bar Diagram” or “Table” for data pages), the attributes for
the page element like name, line diagram axis scaling etc. can be configured.

A double click on the “sensors” entry of a page element opens the “Select Sensor” dialog for the page
element. The sensor(s) assigned to the page element can be edited. If a page element can contain
more than one sensor, like tables or line diagrams, the sequence of the sensors can be changed here.
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A double click on a specific sensor of a page element opens the “Edit Page Element Sensor” dialog for
this sensor. Depending on the page element type, the color of a sensor (for line diagrams) or the
status mapping (for horiz. Bar Diagrams, vert. Bar Graph, Color Code, Table or Pictogram) can be
modified.

6.5 Adding new Data Page

To add a new “data page” to a site, you can either double click on the “Pages” element of the web site,
which will open the “Pages” dialog where you can add a page by clicking the “New” button, or by
selecting the “Pages” entry (or a page entry subordinate to the “Pages” entry) in the “Web
Sites/Pages” display and clicking the right mouse button — which will pop up a menu where you can
select “New".

This opens a dialog to select the page type you would like to add

You can either add a data page, or a “link page” (see below).
If you add a data page, the dialog to select a template for your data page is displayed :

If you selected a template page, a dialog to select the station is displayed. Template pages can only
be used to show data from a specific station. If you like to add a data page that contains data from
multiple stations, you have to set it up manually without using a template.
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Select the station you want to use for the data page.
SmartView checks if there is a logical sensor type assigned to every (active) sensor of the station. If
not, a dialog is displayed to assign the logical sensor types.

Next, the dialog to assign the station sensors to the page elements (diagrams, tables etc), is
displayed. If there are many page elements on the page, you may have to scroll down to see all
assignments.



informatik-werkstatt

Systementwicklung e IT-Management

Only page elements that have sensors assigned will be added to the resulting page.

A dialog showing the new page is shown:
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You can change the pre-set page title and data interval etc. for the page, and check/modify the page
elements etc. before actually saving the page by clicking “OK”. Of course you can change the page at
any time, or re-apply a template page later.

6.6 Adding Stations

To add a new station to a SmartWeb site
Add the new station to the Collector configuration —> SmartView3 menu Edit -> Stations
Have the station polled at least once by Collector, so the sensor configuration of this station is
read from the station
Select “Web-Sites” from the “Edit” menu in SmartView3
Double click the web site entry
Click “Edit Stations” and add the station to the site

For each station you add to the web site, a dialog to select a (station) template page for the station is
displayed:
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You can set up a station without using a template page.
If you selected a template, SmartView checks if there is a logical sensor type assigned to every
(active) sensor of the station. If not, a dialog is displayed to assign the logical sensor types

You can select a logical sensor type from the drop down box. If there is no pre-defined sensor type
that fits you sensor, you can create a new sensor type using the button “Edit (log.) Sensor Types.

A Dialog to assign the station sensors to the page template (i.e. to all the page elements of the
template page) is displayed next:
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The page elements that don’t have a sensor assigned will not be added to the resulting page.
For station pages, a table containing all active sensors of the station is created automatically.
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Click “OK” to add the station (and station page) to the web site.

Customize the new data page to your needs.

6.7 Site configuration dialogs

Following window is displayed when “Edit site” is selected from the main menu :

The main menu will now contain a menu “Web-Sites”, from which actions like “edit” “delete” or “new”
can be selected. Depending on the element that is selected in the window, an appropriate dialog will
be displayed. The same functions (edit/delete/new) can be selected from a pop-up menu that appears
if a “left click” with the mouse is done on the selected element.

The function “Check Site Sensor Configuration” will go through all configured stations and web sites,
and remove inactive (or not longer configured) sensors from the web site configuration (i.e. the tables
and diagrams on station and data pages, and the “station icon” on the overview page). Note that this
could lead to tables and/or diagrams without any configured sensors.

It will also add active (new) sensors to the respective pages — but will not add the new sensors to
tables or diagrams. However, as the new sensors are added to the respective pages, they are
available to configure new diagrams.
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6.7.1

Input Fi

Edit Site Dialog

elds:

Site ID: the site id for this site (read only)

Is Active : the site is active (will be generated/updated) or is not active

Restrict Access : if this box is checked, .htaccess and .htpassword files will be created to
restrict access to the pages of the site.

NOTE: This only works for Apache web server!!

Path to htpasswd : (only if “Restrict Access” is checked) the complete/absolute path to the
htpasswd file (without the filename!). If ftp transfer to the web server is used, the
complete/absolute path to the directory where this ftp user accesses the server needs to be
specified here. If the web server is on the local PC, this should be set to the local path.

Start Page ID : The page id of the page that is to be displayed as start page of the site (default
1 = map page)

Local Path : the local path where all generated pages are written to. All files are written to the
local hard drive using this path. If Use FTP is specified, the files are transferred using ftp as
well

Remote Path : the path (below the directory where the ftp user is logged on to the server) on
the server where the site files are to be placed

Site Header : The site header. This header will appear on top of all pages of the site

Site Footer : The site footer. This footer will appear at the bottom of all pages of the site
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Use FTP: if checked, the generated files are uploaded to the specified server.

NOTE: as the image files (for diagrams) and html files with the measurement data in tables
can get quite big, a fast connection to the web server is recommended

FTP Host: the host name or ip address for the ftp transfer

FTP Port: the port for the ftp connection to the server

Passive Mode : use ftp passive mode to connect to server

FTP User: the ftp user for the ftp transfer

FTP Password : the ftp password for the ftp transfer

Generate Print View : default for new pages - include a “print view” of the page

Data as .csv for download : default for new data pages - include data as .csv file for
download

Table(s) on separate page : default for new data pages - place tables on a separate page
Data interval : default data interval for new data pages (not used with template pages).
Delete Pages containing data older than : automatically delete data pages that show data
which is older than the configured time period.

Diagram Width : the width for all diagrams on all data pages for this site (not used with
template pages)

Line Diagram Height : the height for all line diagrams on this site (not used with template
pages)

Bar Diagram Height : the height for all bar diagrams on this site (not used with template
pages)

Number of Sensors in Diagram : maximum number of sensors in a line diagram

Number of Sensors in Table : maximum number of sensors in a table

Buttons:
Edit Stations : this opens the “Select Site Stations” dialog, where you can specify which
stations are displayed on this site. See Select Site Stations
Apply to all Pages: applies “Generate Print View”, “Data as .csv for download” and
“Table(s) on separate page” to all pages of this site
Reset Pages: re-sets all pages of this site - this will cause SmartWeb to re-generate all
pages for the site

6.7.2 Site Elements

A site always has 3 “Site Elements” - a Site Logo , a CSS File and a Javascript File. These can be
edited by double-clicking on the entry in the list or by selecting the entry and clicking the “edit” button.

See chapter Styles.css for a description of the .css file
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6.7.3 Edit Site Element

The Site Elements “Logo”, “CSS File” or “Javascript File” can be edited here - i.e. they can be read
from a file on the hard drive, or written to a file on the hard drive to be edited and then again read from
the file and stored in the database for use by SmartWeb.

6.7.4 Select Site Stations

This dialog is used to select the stations to be used on a site. To select a station, mark it in the left list
box and click “add”. To remove a station mark it on the right list box and click “delete”.
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6.7.5 Pages

This dialog shows all pages for the site.

Note : only “data” pages and “external link” pages can be deleted or added to a site- all other pages
are pages that are always present on a site.

Deleting a data page will delete the associated “archive list” page.

The “Up” and “Down” buttons can be used to change the sequence of the pages, which changes the
sequence of entries in the “Station List”, “Data List” and “Archive Menu” page.

Following page types exist:

6.7.5.1 Map Page

The map page is the default start page for a site. It shows (if a map has been loaded to the page) the
stations as icons on a map, and the status of the station (status of last transfer). If no Map has been
loaded, the stations and their status is listed.

A Map Page has following “Page Elements”:
One element of type Bitmap which contains the image of the map to be used
One element of type “Station Icon” for each station that is configured to this site

The page elements are maintained automatically, and can not be deleted - but can be edited.
See Edit Page, Edit Map, Page Elements.

6.7.5.2 Station List Page

This “menu page” contains a list of all stations configured for this site. This page does not have page
elements that can be edited.
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6.7.5.3 Data List Page

This “menu page” contains a list of all data pages configured for this site. This page does not have
page elements that can be edited.

6.7.5.4 Archive Menu Page
This “menu page” contains a list of all “Archive List” pages. This page does not have page

6.7.5.5 Other Page / Contact

This is the “contact” page for the site. It contains one Page Element of type “Text". This text is placed
“as is” on the page and may contain any valid html tags.

6.7.5.6 Station Page

This page shows information about a station, the sensors of the station, and the last measurement
values for each sensor.
It may contain “page elements” for
- station information
- one (or more) tables with sensors to display the last sensor value for a sensor
- “Analog Gauge” displays for sensor values to display the last sensor value graphically, e.g. as
“Round Gauge”, “Wind Rose”, “vert. Bar Graph”, “Color Code” or “Pictogram”.

6.7.5.7 Data Page

A data page shows measurement values of sensors configured for this page in diagrams and tables.
Page Elements are Line Diagrams, Bar Diagrams and Tables. Sensors can be configured from all
stations that are configured for the site. Diagrams and Tables can be configured from all sensors that
are configured to the page.

6.7.5.8 Archive List Page

This “menu” page lists all “Archive Pages” for the site. There is an Archive List page for every Data
Page.

6.7.5.9 Archive Page

An Archive Page is a “Data page” that has been closed, i.e. the time interval for the page is in the past
- and no more data is added to this page.

6.7.5.10 External Link
A link to a web-site extern to the SmartView3 generated site. This will appear on the main menu.
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6.7.6 Edit Page

Table(s) on separate page: if checked, tables are placed on a separate html page (data page
only)

Data as .csv for download: if checked, data for all sensors of a data table are included as
.csv file for download from the page

Generate Print View: if checked, a separate html page for printing without site header/footer
and menu, and with white background is generated, and a link to this page is shown on the
corresponding page.

Align Centered: align elements (diagrams, tables etc) centered on page

Show Status Map Color in Table: if selected, all values sensors in tables that have a status
map assigned will be shown with the appropriate color as background of the table cell.
Auto-Refresh Interval: For pages of type “Map”, “Station” or “Data” the auto-refresh interval
(in seconds) can be configured. An interval of 0 seconds disables auto refresh for the page.
Max. Sensors in Status Table: (overview page only) this parameter sets the maximum
number of sensors that are displayed on a status table. If the stations contain more than that
number of sensors, multiple tables are created.

Title: the title for this page

Sub Title: the sub title for this page

Footer: the footer for this page

Data Interval: the data interval for a data page

Station ID: the associated station id for a page

Buttons:
- Apply Template: you can (re-) apply a page template to data or station pages. The

appropriate dialogs (see “Getting started” or “adding data pages” above) are displayed.

Elements: show/edit the elements (diagrams, tables etc) for the page, and change the

sequence of elements on the page

Reset Page: resetting a page will cause SmartWeb to re-generate the page. For data pages,

all “archive” pages with all available data for the page/station are re-generated.

22
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6.7.7 Edit Map

This is the map editor window (Map page only). Click on the white square of the station and move it
(by holding the left mouse button) to the desired position on the map, and release the mouse button.
If the map is bigger than your screen, you may need to move the station icon, and scroll the dialog,
and then move the station icon further.

To load (or change) the map : edit the “Bitmap” page element of the “Map” page.

6.7.8 Select Sensor

23
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This dialog shows sensors to be selected. This dialog is used wherever Sensors can be selected
within SmartView3 (e.g. Sensors for a data page, sensors for diagrams or tables, sensors to be
exported etc.).

Multiple sensors can be selected from the left side (list of available sensors).

Note: if you edit a template page element, a similar dialog to select logical sensor types (instead of
“real” station sensors) is displayed.

Page Sensors : all sensors from all stations configured to the site are shown on the left, and can be
added to the page.

Page Element Sensors : all sensors configured for the page are shown on the left. Sensors can be
added to a line diagram (up to the “number of sensors per line diagram”; or if the maximum of 4 units
per line diagram has been reached). One sensor can be added to a bar diagram - the number of
value/color intervals is asked for, and the sensor is added to the page element sensor list for every
value interval - this way you can configure the color for each value interval for a bar diagram.

The sequence of the selected sensors can be changed by selecting a sensor and using the “up/down”
button.

6.7.9 Page Elements
Only “Map”, “Contact”, “Data” and “Station” pages contain page elements.
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The “Map” page has one element of type “Bitmap” and one element of type “Station Icon” for
each station.

The sensors assigned to the station icon determine, which sensor values are displayed when you
“scroll over” the station icon with the mouse (map display). They determine which sensors (and in
which order) are shown on the overview table as well.

The “Contact” page has one page element of type “Text”

A “Data” page can have one or more page elements of type “Line Diagram”; “Bar Diagram”
“Table”, “Text” and/or “Report”.

If a data page does not have any page elements, default elements can be created by clicking
“Create Dia/Tab".

This will create line diagrams for all sensors except an IRS21 road condition sensor, a bar

24
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diagram for an IRS21 road condition sensor, and tables for all sensors.

A “Station” page always contains a page element of type “Station Information”.

You can select which station information items to be displayed by editing this page element
item.

It also always contains a “Table” element to display the last (current) sensor value for each
configured sensor.

It may contain one or more “Report” page elements with specific time intervals
(day/month/week).

It may also contain one or more “Text” page elements.

A “Station” page may contain “analog gauge” displays like “Round Gauge”, “vert. Bar Graph”,
“Wind Rose”, “Color Code” or “Pictogram” to display the last (current) sensor value for a
Sensor.

The sequence of the page elements can be changed by selecting an element and using the “up/down”
button.
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6.7.9.1 Page Element Types
Following page element types exist:

Station Icon :
An Icon for a station on the map page (map page only).

Bitmap
A bitmap file - used with Site Elements for the site logo, and for the map page for the map.

Line Diagram
A line diagram with up to 4 different Units/Y-Axis (data page only)

Horiz. Bar Diagram
A horizontal bar diagram with different colors depending on the sensor value (data page only)

Table
A table with sensor values (data page only)

Text
A text element (station page, data page, and other/contact page)

File
A file - used for Site Elements CSS file and Javascript File.

Round Gauge
A round gauge display similar to a speedometer.

Wind Rose
A wind rose display to display the wind direction.

Vert. Bar Graph
A vertical bar graph similar to a thermometer.

Color Code
A color code display where a value is mapped to a color (similar to the horizontal bar diagram).

Pictogram
A pictogram display where a value is mapped to a pictogram.

New Line

A “New Line” page element to separate analog gauges — so the next gauge will be displayed on a new
line.

Report

A “Report” page element shows data for the selected sensors for a specified time interval. Report
page elements are similar to the “Report” function available per station in SmartView3, see Chapter

5.2.3 Reports.

6.7.10 Edit Page Element

Depending on the Page Element Type (see above) the Edit Page Element Dialog shows different input
fields :
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6.7.10.1 Edit Line Diagram:

Name: the name of the page element

Width: the width of the element

Height: the height of the element

Interval: data interval for the element (only for “Report” elements on station page).

Align Centered: align element centered on page.

Axis x Auto Scale: Line Diagram only: auto scale diagram to min/max values in interval

Scale Min: if Auto Scale is off, the minimum value for y-axis of the diagram

Scale Max: if Auto Scale is off, the maximum value for y-axis of the diagram

- Unit: the unit of the axis of the diagram

Buttons:
Element Sensors: show/edit the element sensors. See Select Sensor
Edit Font Settings: for diagram/analog gauge only; See “Edit Font Settings”
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6.7.10.2 Edit “Round Gauge” or “vert. Bar Graph®,

Name: the name of the page element

Width: the width of the element

Height: the height of the element

Align Centered: align element centered on page

Scale Min: the minimum value for the scale of the display

- Scale Max: the maximum value for the scale of the display

Buttons:
Element Sensors: show/edit the element sensors. See Select Sensor
Edit Font Settings: for diagram/analog gauge only; See “Edit Font Settings”
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6.7.10.3 Edit Wind Rose

Name: the name of the page element

Width: the width of the element

Height: the height of the element

Align Centered: align element centered on page

Show Airstrip: if this box is checked, an “airstrip” is shown in the center of the wind rose,
aligned in the angle specified as “Direction ”.

Buttons:
Element Sensors: show/edit the element sensors. See Select Sensor

Edit Font Settings: for diagram/analog gauge only; See “Edit Font Settings”

6.7.10.4 Edit vert. Bar Diagram, Color Code or Pictogram
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Name: the name of the page element
Width: the width of the element
Height: the height of the element
Align Centered: align element centered on page
Buttons:
Element Sensors: show/edit the element sensors. See Select Sensor
Edit Font Settings: for diagram/analog gauge only; See “Edit Font Settings”

Note: to assign specific colors and/or pictograms to values for these diagram types, Status Mapping
must be configured for the “Element Sensor” of this diagram.

6.7.10.5 Edit “Station Information”

Select which station information is included in the station information table on the station page.

6.7.10.6 Edit “Table™

Name: the name for the table
Align Centered : align element centered on page
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Buttons:
Element Sensors: show/edit the element sensors. See Select Sensor

Note: to display a descriptive text for a value, Status Mapping may be configured for the “Element
Sensor” in a table.

6.7.10.7 Edit Bitmap:

Text: (Text element only) Text for the element - may contain any valid html tags
Element Data Name: Bitmap and File only - the file name

Buttons:
Read from File: read Bitmap or File from hard disc
Save to file: save Bitmap or File to hard disc
Delete: delete the data (file)
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6.7.11 Edit Font Settings
This dialog allows configuration of font and color settings for diagrams.

Title Font Size: the size for the title text. 0 = use default size. For “analog gauge” diagrams
the default size is calculated depending on the size (height) of the diagram.

Title Color: the color for the title text.

Legend/Value Font Size: for “Line Diagrams” and “horiz. Bar Diagrams”: the size of the font

used for the diagram legend text. For “analog gauge” diagrams the size of the font used for
the value text.

Legend/Value Color: the color for the legend or value text.
Axis Text Font Size: the size for the axis (line diagram) or scale (analog gauge) text.
Axis Text Color: the color for the axis (line diagram) or scale (analog gauge) text.

Date/Time Font Size: the size for the date/time range (line and vert. bar diagram) or date/time
(analog gauge) text.

Date/Time Color: the color for the date/time range (line and vert. bar diagram) or date/time
(analog gauge) text.

Background Color: the background color for the diagram.
Axis/Grid Color: the color used to draw the grid or scale for the diagram or gauge.
Pointer Color: the color used to draw the pointer of an analog gauge.
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6.7.12 Edit Page Element Sensor
Edit a page element sensor

For a line diagram sensor the color of the curve in the line diagram can be specified.

“ow ” o«

For a “horizontal bar diagram®“, “color code”, “table” or “pictogram”, “status mapping” is used to specify
which color/text/pictogram is assigned to a specific sensor value.

For “reports” a sensor/channel can be configured to show sum values instead of average values.
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7 Configure Export/Import

Export/Import tasks are configured as “Export Jobs” in SmartView3. There are “manual’ Export/Import
jobs, or Export/Import jobs that are processed automatically.

The difference between “manual” and “automatic” is, that “manual” jobs are processed within
SmartView3, and only run when you select the job from the list of manual jobs via “file->export/import”
in Smartview3, and click the “Run Job” button. All paths (for export file, import file, or external
programs) refer to the PC where you run SmartView3.

“Automatic” Export/Import jobs are configured in SmartView3 via “Edit->Export/Import”, and are
processed by the SmartCom program — so all paths (for filenames or programs) refer to the PC where
SmartCom runs — which could be different from the PC where you run SmartView3. “Automatic”
Export/Import jobs are run “as configured”, e.g. every day or week or month etc. (see below).

If you click “Export/Import” from the “Edit” menu (or “Manual Export/Import” from the “File” menu), the
following dialog is shown:

On the right side, template export jobs are shown. There are pre-defined template export/import jobs
for the plant disease model calculations available from Lufft. You can create your own Export Job
Templates.

Export Job Templates use “logical” sensor types instead of “real” station sensors. All other attributes
for a template job are the same as for a “real” export/import job.

You can eiher create a new export job “from scratch”, or you can create a new job using a template
job.

7.1 Create an Export/Import job using a Template Jo b

If you want to use a template job, select the template job to be used on the right side, and click “New
Job From Template”.

A dialog to select the station for the new job is displayed. If you plan to export data from multiple
stations in one job, you will need to manually configure the job “from scratch”.

If not all sensors of the station have a logical sensor type assigned, a dialog to assign the logical
sensor types is shown:

34
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Then a dialog to assign the station sensors to the template job is shown:

If (which usually is the case) there are no appropriate import sensors for the station available, the
sensors will be created. For the pre-defined job templates (the plant disease models), this will be done
completely automatically.

The resulting export job is shown next, and can be customized if needed.

Note: if you plan to use the plant disease models provided by Lufft, you need to place them in a folder
“PlantDiseaseModels” below the progam folder, or you will have to change the path for the “Program
Filename” of the template job (or the resulting job) accordingly.
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Details of this dialog are described in the next chapter.



informatik-werkstatt

Systementwicklung e IT-Management

7.2 Export Job Dialog

General parameter:

Is Active: the Export/Import job is active (or not active).

Name: a name for this job

Type : type of job; can be “Export”, “Export+Run”, “Export+Run+Import”, “Run+Import”,
“Import”, “Run”, “FTP”, “Export+Import” or “Run (external export)”

Export : data for the specified “Export Sensors” (see below) are exported in either .csv or .xml
format.

Export+Run : data is exported, and an external program is called.

Import: data for the specified “Import Sensors” (see below) are imported from a file in .csv
format

Export+Run+Import : data is exported in .csv format, an external program (e.g. to calculate
forecasts or “derived sensor values”) is run (which writes its result into a new file in .csv
format), and the resulting data is imported (from the .csv file the external program wrote).
Run+Iimport : the external program is called, and then the specified file(s) is/are imported
Import: the specified file is imported. The filename may contain “wildcard” characters “*” or “?”,
e.g. “C:\Import\*.csv”

Import : the specified file(s) is/are imported. The filename may contain “wildcard” characters
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“7or “?", e.g. “C:\Import\*.csv”

Run: the specified program is executed (no export or import is done)

FTP: the specified file(s) is/are downloaded from the server to the location specified as “import
filename”. No export or import is done. The filename may contain “wildcard” characters “*” or
woyn

Export+Import: data is exported to and imported from the specified file name. No program is
called in between export and import. May be used to scale/change sensor values and re-
import the values as a different sensor (e.g. scale generic mV or mA sensor value to a specific
sensor with proper name/unit etc.).

Run (external export): the specified external program is run. Export sensor can be
configured, but no export file is written. The external program is responsible for reading the
appropriate sensor values from the database itself (used for custom specific export functions,
e.g. export via SOAP client).

Station: the station associated with this export job. If a station is selected, only sensors from
this station can be selected as “export” or “import” sensors. If no station is selected, sensors
from all stations can be used in export and import in this job.

Run Job Every / at/ on day (of week or month) : for “automatic” jobs only, you can specify
the interval the job is run (e.g. every hour, every week etc). For “manual” jobs, this input fields
are disabled

Run Now: clicking this button will reset the “next run” time to now.

Export Settings :

FTP:

Export Format: CSV or XML

Include header: write a line with column names as first line of the export file

Values in quotes: (CSV only) put all values in quotes (“...")

Separator in last column: (CSV only) write a separator character at the end of the last
column

XML Parameter: (XML only) displays a d